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Лабораторная работа № 2 

 

Исследование метода защиты речевых сигналов от воздействия 

широкополосных аддитивных помех 

 

2.1.  Цель лабораторной работы:  

 

Ознакомление с методами защиты радиоэлектронных средств (РЭС) передачи 

речевых сигналов от средств радиоэлектронного подавления (РЭП) при воздействии  

широкополосных аддитивных помех. 

Перед выполнением лабораторного задания студенты должны 

ориентироваться в основных аспектах информатики, знать основные сведения о 

сигналах, помехах и системах передачи информации а также иметь начальные 

знания и навыки по работе с программой редактирования звуковых файлов 

AdobeAudition. 

 В результате выполнения лабораторного задания студенты должны получить 

навыки защиты сигналов от радиоэлектронного подавления при воздействии на них 

широкополосных аддитивных помех. 

2.2. Краткие теоретические сведения 

 

Под помехами (в технике) понимается обширная область явлений (мешающих 

воздействий), препятствующих нормальному функционированию технических 

радиоэлектронных устройств, средств и систем. Воздействие помех на 

радиоэлектронные средства (РЭС) приводит к ухудшению показателей качества их 

функционирования, т.е. подавляет их работу. При этом мероприятия по 

организации намеренного воспрепятствования нормальному функционированию 

РЭС называют радиоэлектронным подавлением (РЭП). Степень отклонения по-

казателей качества функционирования подавляемых РЭС от потенциально возмож-

ных зависит от многих факторов, прежде всего от вида помех и их интенсивности, а 

также от устойчивости РЭС к воздействию помех. 

Различают помехи естественного (природного) или искусственного 

происхождения. 

К первым, в частности, относятся: тепловое (электромагнитное) излучение 

Солнца, Луны, планет, земной поверхности и предметов, находящихся на ней; 

атмосферные электромагнитные излучения (ЭМИ), обусловленные, например, 

грозовыми разрядами; ЭМИ фона околоземного пространства (вызываемые потоком 

заряженных частиц в верхних слоях атмосферы) и т.п. 
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ЭМИ искусственного происхождения - искусственные радиоэлектронные 

помехи (радиопомехи) - создаются различными техническими (например, 

промышленными) средствами (в том числе РЭС), излучающими электромагнитную 

энергию, а также объектами, отражающими (рассеивающими) эту энергию.  

Радиопомехи могут быть неорганизованными (непреднамеренными, 

неумышленными) и специально организованными (преднамеренными, 

умышленными). 

Неорганизованные радиопомехи РЭС возникают за счет воздействия на 

приемные устройства РЭС электромагнитных излучений (ЭМИ) РЭС и других 

технических средств и устройств (электродвигателей, бытовых приборов, ап-

паратуры электросвязи, высоковольтных линий передач, высокочастотной 

аппаратуры различного назначения и т. д.). Радиопомехи, создаваемые 

перечисленными техническими средствами и устройствами, называются 

индустриальными или промышленными.  

Неорганизованные радиопомехи, обусловленные одновременной работой 

нескольких РЭС в общем диапазоне частот, называют взаимными. Они возникают в 

тех случаях, когда спектры частот ЭМИ одних РЭС находятся в пределах полос 

пропускания приемников других. Это приводит к проблемам электромагнитной 

совместимости (ЭМС) РЭС между собой. 

Организованные радиопомехи создаются преднамеренными действиями 

злоумышленников в целях снижения эффективности функционирования 

подавляемых РЭС. Для их создания применяются специальные средства и 

устройства (станции и передатчики радиопомех, дипольные, уголковые и линзовые 

отражатели и т.п.). Создание помех возможно также преднамеренным воздействием 

на среду распространения электромагнитной энергии, излучаемой или при-

нимаемой РЭС. В результате воздействия на среду могут возникать искусственные 

локальные или протяженные образования (например, искусственные 

ионизированные области в атмосфере), параметры которых отличаются от 

параметров окружающей среды распространения ЭМИ от источника к приемному 

устройству. 

Создание радиопомех является одним из основных способов подавления РЭС, 

так как независимо от назначения и типа их приемные устройства подвержены (при 

соблюдении определенных условий) воздействию нежелательных 

электромагнитных излучений - помеховых сигналов.  

Под помеховым сигналом понимают напряженность en(t) электрического поля 

внешнего мешающего электромагнитного излучения, действующего на входе 

приемной антенны, или напряжение un(t) на выходе приемника подавляемого РЭС, 

выраженные как функции времени. 
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Организованные радиопомехи можно классифицировать по способу 

формирования, конечному результату (эффекту) воздействия на РЭС), 

соотношению ширины спектра помехового сигнала и полосы пропускания 

подавляемого канала РЭС, классам и назначению подавляемых РЭС, способам 

создания и т. д. 

В зависимости от способа формирования (образования) организованные 

радиопомехи могут быть активными, пассивными и комбинированными 

(активно-пассивными). 

Активные организованные радиопомехи создаются специальными 

передатчиками или станциями радиопомех, излучающими помеховые сигналы той 

или иной структуры. 

По структуре (закону изменения параметров во времени) помеховые сигналы 

могут быть детерминированными (неслучайными) или случайными, 

непрерывными или импульсными, немодулированными или модулированными, 

узкополосными или широкополосными. 

Детерминированные помеховые сигналы - сигналы, описываемые 

определенной функцией времени. Это, например, непрерывные немодулирозапные 

высокочастотные синусоидальные колебания, непрерывные синусоидальные 

колебания, модулированные по амплитуде синусоидальным колебанием. 

Случайными называют помеховые сигналы, параметры которых (или хотя бы 

один из параметров) изменяются во времени случайным образом, т. е. являются 

случайными функциями времени. Примером служат шумовые помеховые сигналы. 

Непрерывные помеховые сигналы - это высокочастотные де-

терминированные или случайные колебания, непрерывно изменяющиеся во 

времени. 

Импульсные помеховые сигналы представляют собой прерывистые во 

времени последовательности высокочастотных колебаний. 

Параметры непрерывных (амплитуда, частота, фаза) и импульсных 

(амплитуда, длительность импульсов, временное положение относительно 

импульсов полезных сигналов) могут изменяться преднамеренно во времени по 

детерминированному или случайному закону в соответствии с законом изменения 

параметров модулирующего колебания. В этом случае помеховые сигналы 

называют модулированными. 

Непрерывные модулированные помеховые сигналы в зависимости от 

модулируемого параметра подразделяют на амплитудно-, частотно- и фазо-

модулированные сигналы.  

Импульсные помеховые сигналы, параметры которых изменяются во времени 

по случайному закону, называют хаотическими импульсными помехами. 
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Помеховые сигналы в зависимости от соотношения с полосой частот 

подавляемого сигнала могут быть узкополосными и широкополосными. 

Узкополосные помеховые сигналы (УПС) используются тогда, когда 

подавляется РЭС с известной полосой частот полезного сигнала. При этом спектр 

частот УПС должен совпадать со спектром частот подавляемого сигнала. 

Широкополосные помеховые сигналы используются тогда, когда подавляется 

РЭС с неизвестной точно полосой частот сигнала, либо при подавлении группы 

РЭС с близко-расположенными спектрами частот их полезных радиоизлучений.  

Выбор структуры помехового сигнала (при формировании в передатчиках или 

станциях помех, т.е. при организации РЭП) зависит от структуры построения 

приемного устройства и структуры полезного сигнала подавляемого РЭС, от 

требуемого (заданного) эффекта воздействия помехового сигнала (подавление по-

лезного сигнала, маскировка полезного сигнала или его имитация и др.). 

Активные организованные радиопомехи используются для подавления всех 

без исключения РЭС. 

Пассивные  организованные радиопомехи возникают вследствие отражения 

(рассеяния) электромагнитной энергии, излучаемой РЭС, от искусственно 

(преднамеренно) создаваемых образований (облаков или протяженных полос 

дипольных отражателей, например, в виде полосок алюминиевой фольги, 

уголковых или линзовых отражателей, специальных аэрозолей и т.п.).  

Помеховый сигнал, возникающий за счет отражения, чаще всего является 

случайным. Так, при отражении от облака дипольных отражателей радиоволн 

результирующий помеховый сигнал, воздействующий на подавляемое РЭС, пред-

ставляет собой сумму элементарных сигналов, отраженных каждым из диполей 

искусственного образования, попавшим в поле зрения диаграммы направленности 

антенны подавляемого РЭС. При этом  результирующий помеховый сигнал, 

воздействующий на РЭС, по ряду причин (хаотичного расположения диполей, их 

непредсказуемого перемещения и т.п.) будет случайным. 

Структура (параметры) «пассивного» помехового сигнала, воздействующего 

на подавляемые РЭС, должна определяться: 

1. структурой полезного сигнала РЭС; 

2. взаимным пространственным положением подавляемого РЭС и данного 

искусственного образования; 

3. количеством элементарных отражателей, попавших в «поле зрения» 

диаграммы направленности антенны подавляемого РЭС; 

4. и рядом других причин. 

 

Помимо задачи подавления РЭС заданных видов, при создании пассивных 

радиопомех могут решаться задачи маскировки или имитации сигналов РЭС. 
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Комбинированные (активно-пассивные) организованные радиопомехи 

образуются за счет отражения (рассеяния) электромагнитной энергии, излучаемой 

станцией радиопомех в направлении искусственного или естественного 

образования. 

Структура помехового сигнала, воздействующего на подавляемое РЭС, 

определяется в этом случае:  

1. структурой помехового сигнала станции помех;  

2. параметрами отражающего образования;  

3. взаимным пространственным положением источника облучения 

(станции помех), облучаемого образования и подавляемого РЭС; 

4. скоростью изменения взаимного пространственного положения;  

5. и рядом других факторов. 

В зависимости от конечного результата воздействия на РЭС активные и 

пассивные радиопомехи разделяются на маскирующие и имитирующие. 

При воздействии маскирующих радиопомех (маскирующих помеховых 

сигналов) на входе приемного устройства подавляемого РЭС создается мешающий 

фон (в дополнение к фону, образованному внутренними шумами приемника), 

который исключает или затрудняет получение полезной информации. При 

воздействии помех структура результирующего сигнала, действующего на входе 

приемника РЭС, может в значительной степени отличаться от структуры 

принимаемого полезного сигнала. 

Маскирование может осуществляться по параметрам полезного сигнала 

(амплитуде, несущей частоте, фазе, спектру), по параметрам местоположения 

источника полезного сигнала (угловым координатам, дальности), по радиальной 

скорости движения (доплеровскому изменению частоты сигнала) и т.д.  

В результате маскирования ухудшаются характеристики приема элементов 

сигнала (снижается вероятность правильного обнаружения или повышается 

вероятность ложной тревоги элементов полезного сигнала), затрудняется выделение 

передаваемых сообщений (команд) в линиях радиосвязи (или телеуправления), уве-

личиваются ошибки определения параметров принимаемых полезных сигналов 

приемниками подавляемых РЭС и т.п. 

Эффективность маскирующих радиопомех зависит от частотной и временной 

структуры как помехового, так и полезного сигналов и их энергетического 

соотношения на входе приемника подавляемого РЭС. 

В качестве активных маскирующих радиопомех используются 

преимущественно непрерывные шумовые сигналы. Пассивные маскирующие 

радиопомехи создаются искусственными образованиями большой протяженности 
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на пути распространения радиоволн (т.е. изменяются свойства среды 

распространения). 

Имитирующие радиопомехи вносят ложную информацию при приеме и 

обработке сигналов, принимаемых подавляемыми РЭС. Значения параметров 

имитирующего помехового сигнала (поляризация, несущая частота амплитуды,  вид 

модуляции и др.) обычно близки к значениям параметров полезных сигналов, ис-

пользуемых в РЭС для получения полезной информации. Имитирующие 

радиопомехи используются при радиоэлектронном подавлении РЭС связи, 

радиолиний АСУ, командных радиолиний управления и т.п. 

Одними из методов защиты РЭС от воздействия помех является 

использование различных методов фильтрации принимаемых сигналов. В 

простейших случаях используется частотная фильтрация с помощью помеховых 

полосовых фильтров (в случае широкополосной помехи) или частотной режекции с 

помощью   режекторных (подавляющих) фильтров (в случае узкополосной 

помехи). При этом полоса пропускания помехового фильтра должна совпадать с 

полосой пропускания полезного сигнала, чтобы не исказить его параметры, не 

пропуская при этом на вход приемного тракта РЭС внеполосную часть энергии 

помехи. Аналогично, полоса подавления режекторного фильтра должна совпадать с 

полосой сигнала помехи. 

Этот метод обеспечивает повышение соотношения сигнал/помеха в случае, 

если спектр помехи значительно шире спектра полезного сигнала, за счет 

уменьшения энергии сигнала помехи на входе приемного тракта РЭС. 

2.3. Лабораторное задание  

1. При подготовке к лабораторному занятию изучить следующие вопросы: 

воздействие широкополосной помехи на узкополосный полезный сигнал, а 

также методы редактирования сигналов в программе AdobeAudition. 

2. Запустить программу AdobeAudition, кликнув ее значок на Рабочем столе 

(если он имеется), либо запустив ее из Основного меню компьютера или 

Проводника. 

3. Установить режим Моно, после чего открыть звуковой файл речи из папки 

AdobeAudition:  

 

Menu > File > Open >  Audition 1.5 > Samples > speech_dft.mp3 > Open  

 

При этом на экране появится изображение временной диаграммы речевого 

сигнала. 
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4. Прослушать сигнал, например,  с помощью подключенных к компьютеру 

наушников. 

5. Предварительно выделив сигнал с помощью мыши (поместив указатель мыши 

на начало сигнала и нажав левую кнопку мыши, двигая ее слева направо до 

конца области сигнала, после чего отпустив левую кнопку мыши) и 

ограничить полосу частот речевого сигнала путем его полосовой фильтрации 

в полосе частот 300-3400 Гц: 

 

Меню > Effects > Filters > FFT Filter   

и, нажав правую кнопку мыши установить границы требуемого полосового 

фильтра с помощью движков (белых квадратиков) в заданной полосе частот 

300-3400 Гц (см. рис. 2.1) 

 

 

 

Рис. 2.1 
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Затем - <Ok> и - прослушать сигнал. 

 

6. Установить уровень отфильтрованного звукового сигнала, равный – 10 db: 

 

Menu > Effects > Amplitude >  Amplify/Fade   

 

и, используя указатель  мыши, а также движок в окне  Amplification, 

установить в окне заданный уровень речевого сигнала (– 10 db) и затем опять 

прослушать измененный по уровню речевой сигнал. 

 

7. Используя мышь, скопировать этот сигнал в буферную память компьютера 

(Clipboard): 

 установить курсор мыши во временную позицию  начала сигнала, 

нажать левую кнопку мыши и, не отпуская, двигать курсор мыши  слева 

направо до конца окна, после чего отпустить левую кнопку мыши; 

 нажать правую кнопку мыши  и в появившемся окне выбрать Cut 

(Вырезать) (при этом окно станет пустым). 

 

8. Сгенерировать шумовой сигнал в виде сигнала белого шума длительностью 5 

сек. и амлитудой – 36 дБ: 

 

Меню > Generate > Color: White > Intensity:  36 > <Ok> 

 

и прослушать его. 

 

 

9. Сформировать полосно-ограниченный по частоте шумовой сигнал в полосе 

частот 0 – 300 Гц аналогично п. 5.  

 

10.  Используя опцию Mix Paste, прибавить  к отфильтрованному шумовому 

сигналу сохраненный в буферной памяти речевой сигнал:   

 

Меню > Edit Меню >  Mix Paste  

 

11. Наблюдать временную диаграмму зашумленного речевого сигнала на экране 

монитора. Прослушать полученную смесь сигналов. 

12.  Вернуться с помощью функции Откат (Ctrl-Z)  к п. 9 и последовательно 

увеличивая уровень шума добиться полного сокрытия речевого сигнала.  
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13. Результирующий сокрытый речевой сигнал сохранить в файле 

ShadowSpeechSig.mp3. 

ПОРЯДОК ВЫПОЛНЕНИЯ ЗАНЯТИЯ 

 При выполнении задания рекомендуется соблюдать следующую 

последовательность: 

1. Изучить методические указания  к данному лабораторному занятию. 

2. Получить у преподавателя задание. 

3. Выполнить лабораторную часть 

4. Ответить на контрольные вопросы. 

СОДЕРЖАНИЕ ОТЧЕТА 

1. Краткие теоретические сведения по видам подавления РЭС и методам их 

защиты. 

2. Выполненное задание по заданному преподавателем варианту. 

3. Временные диаграммы полученных результатов. 

 2.4. КОНТРОЛЬНЫЕ ВОПРОСЫ 

1. Классификация помех по их происхождению? 

2. Классификация помех по их организации? 

3. Классификация помех по способу их формирования? 

4. Классификация помех по их структуре? 

5. Как разделяются в зависимости от конечного результата воздействия на РЭС 

активные и пассивные радиопомехи? 

6. К какому виду помех относится помеха, применяемая в данной работе? 

7. Каким методом можно повысить помехозащищенность приема речевых 

сигналов при воздействии широкополосной помехи типа белого шума? 

8. Каким методом можно повысить помехозащищенность приема 

широкополосных сигналов при воздействии интенсивной узкополосной 

помехи? 

 

2.5 Библиографический список 

2.5.1.Основная литература 

1.Методические указания к данной лабораторной работе. 

2. Конспект лекций. 
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3. Лукьянюк С.Г. Теория электрической связи. Сигналы, помехи и системы 

передачи: учебное пособие. / С. Г. Лукьянюк, А. М. Потапенко. – Курск.: Юго-Зап. 

гос. ун-т., 2012. - 223 с.    

         2.5.2. Дополнительная литература 

 

1. Основы теории радиоэлектронной борьбы. /Под ред. Николенко Н.Ф.  М.  

Военное издательство, 1987. -196 с. 

2. Осипов А. С. Военно-техническая подготовка. Военно-технические основы 

построения средств и комплексов РЭП : учебник / А.С. Осипов ; под науч. 

ред. Е.Н. Гарина. - Красноярск : Сиб. федер. ун-т, 2013. - 344 с. 

3. Меньшаков Ю.К. Защита объектов и информации от технических средств 

разведки. Учеб. пособие. –М.: РГГУ, 2002.-399 с. 

4. Запечников С.В., Милославская Н.Г., Толстой А.И., Ушаков Д.В. 

Инфокоммуникационная безопасность открытых систем: Уч. Для вузов. В 2-

х томах. Том 1 – Угрозы, уязвимости, атаки и подходы к защите.  М.: 

Горячая линия – Телеком, 2006. – 536 с. 

5. Макаренко С. И. Информационная безопасность: учебное пособие для 

студентов вузов. – Ставрополь: СФМГГУим. М. А. Шолохова, 2009. – 372 с.: 

ил. 

6.  Варфоломеев А.А. Основы информационной безопасности: Учеб. пособие. – 

М.: РУДН, 2008. – 412 с.: ил. 

 


